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Before you Begin 

NOTE: iSuccess uses audio. Ensure that your speakers 
are turned on or you are wearing headphones. 

We recommend that you listen to the audio, because it 
explains in full detail the highly abbreviated information 
that is presented on the screen If you do not want audio, 
select Sound On/Off at the top of the screen to turn it 
off. The audio stays off until you turn it on again (by 
selecting Sound On/Off). If you turn the sound off or do 
not have an audio feature on your computer, you can 
view the audio scripts by selecting Narrator Script 
and/or Coach Script on each screen.  There is also a 
print version of this course, which includes the audio 
scripts, that you can access using the Print option (top 
right side of screen).This program has a number of 
function keys that will be explained later in the program. 
For the function keys to work, you will need to turn off the 
pop-up blocker on your internet browser. That process 
will vary by browser. For Internet Explorer, the option is 
in the Tools drop-down menu at the top of the internet 
browser screen. 

Select Next to continue. 
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Narrator Script: 

Welcome to iSuccess (interactive Success). This interactive session will help you create your own SMART 
performance objectives and a Self-Report of Accomplishments. Through iSuccess you can:  

• Learn to write performance objectives that align with your organization’s goals and priorities. 
• Practice writing your performance objectives using the SMART framework. SMART stands for Specific, 

Measurable, Achievable, Relevant, and Time-bound. 
• Understand the importance of performance elements. 
• Translate your performance objectives and performance elements into a Self-Report of 

Accomplishments. 

iSuccess takes approximately one hour to complete; however, you may  go at your own pace. When finished, 
you can save your work onto your desktop computer for future use. 

To support you, iSuccess provides a coach to guide you through the process and three virtual employees to 
illustrate key concepts. 

Select Next to start. This button is the right-facing arrow at the lower right corner of your screen. 
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Narrator Script: 

Welcome to About iSuccess. In this lesson, you will learn about the primary features of this program, such as 
the general screen layout, navigation capability, and keyboard shortcuts. 
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Getting Started 

• If you are unfamiliar with the DCIPS 
performance management system, we 
encourage you to take DCIPS 101.  

• Have your position information available. 

 

Select Next to continue. 

 
 
 
 
 
 
 
 
 
Narrator Script: 

Before starting iSuccess,  you should take DCIPS 101—a web-based course that provides a complete 
overview of the core DCIPS elements. 

Also, you will find it helpful to have your position information, including your work category (e.g., professional), 
your work level (e.g., full performance), your grade or pay band, and your position description. 
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iSuccess Features 

• Learn and practice screens  
• Coach  
• Virtual employees  
• Ability to generate and save performance 

objectives and Self-Reports of 
Accomplishments to your computer 

iSuccess takes approximately one hour to complete. 

 
Select each link to see where that item appears. 

 

 

 

Narrator Script: 

iSuccess contains the following features: 

• Learn and practice screens present guidelines, questions to consider, and directions for completing 
activities. 

• A coach is available on certain screens to provide tips, questions, key words, suggestions, and other 
guidance to help you complete the activities. Select the coach icon when you want additional advice. 

• Three virtual employees provide examples of how to complete each activity. To see their examples, 
select the employee icons. 

• The Generate Document button at the end of the course creates a file containing your performance 
objectives, self-report of accomplishments, and other supporting information that you can save on your 
computer for future use. 
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Virtual Employee pop-ups: 

Meet Kyle Staten 

Kyle Staten is an Intelligence Analyst, GG-0132-12. He is in the Professional work category; and is at the Full 
Performance work level. 

Meet Vera Belrose 

Vera Belrose is a Security Specialist, GG-0080-09. She is in the Professional work category and is at the 
Entry/Developmental work level. 

Meet Josh Gregor 

Josh Gregor is a Budget Analyst with NGA. His job is classified as IA-560-3. He is in the Professional work 
category and is at the Full Performance work level. 
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Navigating Through iSuccess 

 

 
 
Select the highlighted areas to learn more, then select Next to continue. 

Narrator Script: 

Here, you see the main areas of the iSuccess screen. Select each highlighted area for a description. When you 
are finished, select Next to continue. 

 

Highlighted Areas: 

 
Menu 

You can progress through iSuccess by either selecting the Next button or by selecting the Menu button.  

In the course menu, module titles have buttons to their left. Selecting one of these buttons expands the module 
to show the list of topics in that module. Selecting the module title takes you to the first screen of that module. 
Topic titles work the same way.  

Select the Menu button in the main interface outside of this screen capture to see how this looks. 

Resources 

 
The Resources button opens a separate window with a list of references and training items related to the 
content of iSuccess. 
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Print 

If you wish to print screens from the course (including audio scripts and virtual employee text for those 
screens), select the Print button. A dialog box appears with options as follows:  

Print the entire course - opens a PDF file that includes screen shots of all screens in the course. Audio 
scripts and virtual employee text (if any) are included for each screen. Once the PDF opens, select File>Print. 
This PDF is also available in the Resources section.  

Print text entered in fields - opens a web page with the text you have entered in this session in the fields, 
listed by screen, which you can then print using File>Print. This is provided so that you have a record of what 
you have done at any time, in case you want to go back to an earlier screen and restart the process from there. 

Coach Script 

The Coach Script button opens a pop-up window that contains the coach audio script for the current screen 
only.  

If you wish to see the scripts for all screens, select Print>Print the entire course. This opens a PDF that 
contains the screen contents and all audio scripts, which you can view or print. 

Narrator Script 

The Narrator Script button opens a pop-up window that contains the narrator audio script for the current screen 
only.  

If you wish to see the scripts for all screens, select Print>Print the entire course. This opens a PDF that 
contains the screen contents and all audio scripts, which you can view or print. 

Sound On/Off 

The Sound On/Off button controls all audio in the course. It mutes the audio for the rest of the course or until 
you turn it on again. To turn the sound back on, select it. 

Replay 

The Replay button controls the narrator audio only. This button replays the narrator audio from the beginning. If 
you select Replay while listening to the coach audio or audio attached to a pop-up box, that audio is stopped 
and the narrator audio starts from the beginning.  

If you wish to replay the coach audio (if it is available on that screen), select the coach icon. If the narrator 
audio is playing, it will stop, and the coach audio will play from the beginning. After the coach audio has 
finished, you can select Replay to hear the main narration again. 

Pause/Play 

The Pause/Play button controls the narrator audio only. This button pauses and resumes the narrator audio on 
the current screen only. If you pause the narrator audio to listen to the coach audio or audio attached to a pop-
up box, and then select Play, that audio is stopped and the narrator audio resumes from where it was paused. 
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Breadcrumb 

The breadcrumb is read-only text that shows which module and topic you are currently viewing. 

Progress Bar 

The progress bar is a read-only indicator that tells you how much of the course you have viewed. It determines 
this by looking at your current screen position, relative to the final screen. This bar shows you how far you have 
progressed through the course, not the module. The screen indicator box between the Back and Next buttons 
shows where you are within the module. 

Prompt 

At the lower left of the content area is the prompt. The prompt tells you what you need to do to progress to the 
next screen. On screens with selectable items, the prompt changes as you interact with the screen, telling you 
what to do next (if there is a prescribed order). 

Back 

The Back button takes you to the screen located before the current screen in the sequence of screens for the 
current module.  

If you use the course menu to jump between screens in different modules and topics, you can right-click the 
screen and select Back to go to the previous screen viewed, regardless of the sequence of screens in that 
module or topic. This is the same as selecting the standard Back button in the browser. 

Screen x of y Indicator 

This area indicates the sequential number of the screen at your current location in the module (x), and the total 
number of screens in the module (y).  

This indicator shows you how far you have progressed through the module, not the course. The Progress bar 
at the top of thr screen shows you how far you have progressed through the course. 

Next 

The Next button takes you to the next screen in the course. If you are at the end of a module or topic, selecting 
Next takes you to the first screen of the next module or topic 

Exit 

The Exit button opens a dialog box asking if you want to exit the course. Select Yes to exit and close the 
browser window.  

Your location will not be saved when you exit, so you may want to make a note of where you are so that you 
can navigate to it in your next session.  

NOTE: Any text you entered in this WBT cannot be saved within the program and will not be saved when you 
exit unless you generate and save the file at the end in the final Generate My Objectives and Self-
Assessments module. 
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Keyboard Equivalents for Navigation 

• ALT and A replays the audio on a screen.  
• ALT and B navigates back to the previous 

screen.  
• ALT and N navigates forward to the next 

screen.  
• ALT and M opens the menu.  
• ALT and X opens the exit prompt.  
• ALT and R opens the resources window.  
• ALT and P opens a dialog box with options 

for printing screens.  
• ALT and S opens the narrator script 

window.  
• ALT and C opens the coach script window.  
• Tab moves focus to the next field or screen 

control.  

If you forget any of these, you can always find the 
list in Resources.  

 

Narrator Script: 

In addition to using your mouse, you can use keys to perform some of the same functions. 
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Select Guidelines for Writing Performance Objectives, then select Next to continue. 

Narrator Script: 

Welcome to the iSuccess Introduction module. This module introduces you to the purpose of iSuccess. This 
program will work with you in developing strong performance objectives. Sound, well-written performance 
objectives and an accurate Self-Report of Accomplishments are crucial to effective performance management. 
iSuccess helps you to create your own SMART performance objectives with an understanding of performance 
elements. Also, it reviews how to use your performance objectives, along with your performance elements, to 
create a Self-Report of Accomplishments that focuses on the results of your efforts and their ultimate tie to the 
mission. 

By selecting Guidelines for Writing Performance Objectives on this screen, you will see DoD guidance 
regarding writing performance objectives. This training is derived from these guidelines. 
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What is iSuccess? 

 

 
 
 
Narrator Script: 

Before starting, here are a few things to consider: 

It helps to have the following information ready and available: your position information, including your work 
category (e.g. professional); your work level (e.g. full performance); your grade or pay band; your position 
description; and your organization’s mission statement, goals, and priorities. 

Have handy any guidance from your supervisor or component regarding writing performance objectives. Also, 
it may be helpful to have a copy of the IC Performance Standards and DoDI 1400.25 v2011 “Performance 
Management” tables 1 and 2, which outline the General Standards for rating objectives and elements. Both the 
“IC Performance Standards” and the v2011 General Standards tables are used together to provide a common 
standard for all components to use when rating objectives and elements. Those can be found in the Resources 
section of this course.  

The draft performance objectives you create in iSuccess are a starting point. You will need to discuss them 
with your supervisor. Your discussion should also include expectations about performance elements. From this 
discussion, your supervisor may decide to fine-tune your performance objectives or refocus them based on 
priorities. 
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Why Are Effective Performance Objectives Important? 

An important part of DCIPS performance 
management is good performance objectives, 
which include: 

• Describing how your work supports overall 
departmental and organizational strategic 
initiatives and goals 

• Promoting communication and shared 
understanding with your supervisor about 
expectations for your performance 

• Providing a useful guide for assessing your 
progress toward and success at meeting 
your performance objectives 

• Providing a framework for assessing your 
performance against the standard 
performance elements 

• Providing a basis for evaluating your 
performance 

• Serving as a basis for determining your 
eligibility for a payout through the pay pool process 

 

Narrator Script: 

You may be wondering: "Why bother setting performance objectives in the first place?" DCIPS requires them 
for several good reasons. 

Performance objectives give you a sense of purpose by focusing your efforts on work that is important to your 
organization’s goals and mission. 

Meaningful performance objectives promote good communication between you and your supervisor and help 
you and your supervisor understand what is expected of you and how your performance will be evaluated. 
They provide a useful guide for assessing your progress and a framework for evaluating your performance 
against the standard performance elements. 

Performance objectives provide a basis for evaluating your performance: the “what” you did through your 
performance objectives as well as the “how” you accomplished your work through performance elements and 
for determining your eligibility for a payout through the pay pool process. 
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Why Performance Objectives are Important 

 
 
 
Narrator Script: 
 
Performance objectives, along with the performance elements, drive the performance management process. 
Any financial outcome of your performance is considered through the pay pool process, which we will briefly 
discuss later. 
 
Coach Script:  

Well-crafted performance objectives ease every step in the performance management process. The more 
specific they are, the better, and they should always be written at the “successful” level. Here's an example of 
why: 

Imagine that it is at the beginning of the year, and one of your performance objectives is to "create a year-end 
report on spending within the department." 

At the end of the year, you create a high-level, one-page report that summarizes the categories of spending 
and how much was spent over the past year. You think that you have accomplished the performance objective. 
Your supervisor, however, is disappointed, having expected a more detailed report with an additional analysis 
giving a year-by-year comparison in addition to this year’s spending. 

You receive a low rating for not meeting expectations. You are frustrated because you did not fully realize the 
standards against which you were being rated. 

This situation could have been avoided if you and your supervisor had crafted the performance objective to 
specify the scope of the report, the expected level of analysis, and the outcome. You and your supervisor 
should have a shared understanding of what is expected during the evaluation period and what the 
“successful” level looks like according to established standards. 
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Why Performance Objectives are Important 

 

Narrator Script 

As a part of planning, you and your supervisor discuss and establish expectations for the performance 
evaluation period. Performance expectations should support and align with the mission and goals of the 
Defense Intelligence Strategy, the Defense Intelligence Guidance, the National Intelligence Strategy, 
organizational program, and policy objectives. 

Performance objectives capture the performance expectations, documenting the main targets toward which 
you work during the year. These objectives are not duty or task lists. The performance objectives should be 
thought of as those “big bucket” items you are expected to perform throughout the performance evaluation 
period. 

As they are an expression of performance expectations, performance objectives are written to be appropriate 
to your work level. Writing the performance plan is your supervisor’s responsibility, but ideally it is created as 
the result of a dialogue between your supervisor and you. When writing the objectives, you and your supervisor 
should review and discuss the performance standards so that there is a clear understanding of what successful 
performance looks like. 

Planning should also include a discussion about the performance elements and behavioral expectations. 

You will also create an Individual Development Plan – an IDP. The IDP documents the strategy and priorities 
of increasing your value to the organization. 
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Why Performance Objectives are Important 

 

Narrator Script 

The develop and monitor phase continues throughout the year. At its heart is regular, meaningful dialogue 
between you and your supervisor about performance and behavioral expectations issues. 

Monitoring includes your supervisor tracking your performance and providing feedback that addresses 
accomplishments as well as any challenges, such as making changes to performance objectives or providing 
counseling or learning opportunities for performance deficiencies . If necessary, supervisors can initiate actions 
to address barriers to successful performance. 

Your supervisor has the primary responsibility for providing performance-related feedback, but you share some 
responsibility. Whenever appropriate, you should identify and communicate successes and difficulties related 
to your assigned performance expectations relative to your performance objectives and/or performance 
elements. You should request periodic dialogue and feedback regarding your performance. 

While informal feedback should be frequent and meaningful, DCIPS also requires a formal session. Your 
supervisor uses the mandatory midpoint performance review conversation to acknowledge your achievements 
in the context of expectations and suggest areas for improvement. 

Developing your performance is also part of the midpoint performance review conversation. You will discuss 
progress against your IDP, or performance plan. This review may be an opportunity to modify the IDP, or 
performance plan, if changes are needed. 

To ensure that you and your supervisor remember important events and accomplishments during the year, it 
also is useful for both parties to document performance throughout the performance period. 
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Why Performance Objectives are Important 

 
 
 
Narrator Script: 

An integral part of the performance management process is your Rating Official’s assessment of your 
accomplishments related to performance objectives and performance elements. 

For your part, you complete the required Self-Report of Accomplishments, which documents your performance 
in the context of your performance objectives and performance elements. 

Your rater completes your evaluation for the performance period, using your self-report along with his or her 
monitoring and observations. 

A Reviewing Official checks your Rating Official’s recommendation with three considerations in mind: Are the  
conclusions reasonable? Were the standards applied consistently? Did your rater adhere to policy? 
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Why Performance Objectives are Important 

 

Narrator Script: 

The pay pool process governs the reward phase. Once the performance evaluation of records are provided to 
the pay pool panels, the performance evaluation period ends and the pay pool process phase of “pay” can 
begin. The pay pool panel determines performance payouts for all employees in the pay pool based on 
performance during the performance period. Payout decisions are then communicated to employees by their 
supervisors. Your component can provide more information on how this information is communicated. Much 
more specific information on the pay pool process and its interdependent relationships with the performance 
management process can be learned through the web-based training course “Pay Pools, Performance, and 
You.” For this course, we focus on writing your performance objectives in the plan phase and your self-report 
of accomplishments in the rate phase. 
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What are Performance Objectives and Elements Descriptors? 

These items are the standards used across the 
enterprise to rate performance objectives and 
elements. Objectives descriptors distinguish 
between levels of performance. Supervisors apply 
these descriptors when rating the accomplishment 
of performance objectives. 

 
 
 
 
 
 
 

 
 
 
Select the coach icon to learn more. 
 
 
Narrator Script: 

While performance objectives describe what should be accomplished, objectives descriptors help to establish a 
consistent level of evaluating performance across the intelligence community. They are guidelines that provide 
a consistent measuring stick for the DCIPS community. 

Coach Script: 

To see how performance objective descriptors are used to evaluate your performance, let’s look at a very 
general example. Your performance objective was to create a year-end departmental spending report of no 
more than five pages, which details both current year and year-over-year spending and recommends how to 
address shortfalls. 

At the end of the year, you create a five-page report that details, by category, spending for the past fiscal year 
and compares it to the previous year’s spending. You also made recommendations on how shortfalls should be 
addressed in the coming year. So, you have accomplished your performance objective. However, how should 
your performance be rated? 

Since you achieved the expected results and produced a high-quality, technically sound document, according 
to the objectives descriptors, your performance would deserve a successful rating. If you accomplished your 
performance objective AND your recommendations for future years included innovative and actionable 
recommendations on how to more effectively manage or allocate resources without reducing services, this 
performance  could be considered as having a greater impact on mission that "surpassed expected results in a 
substantial manner" and earn an "excellent" rating. 
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What are Performance Elements? 

 
 
Select the coach icon to learn more. 
 
Narrator Script: 

Performance elements are a standard set of behaviors for all DCIPS positions and are further defined by work 
behaviors and standard descriptors for the different work levels and work categories. The final two behaviors 
differ slightly for employees and managers/supervisors due to the work expected of the two categories. 

Performance objectives describe “what” you are expected to accomplish. Performance elements are the 
important work behaviors associated with “how” you accomplish your work. Just as the objectives descriptors 
help to evaluate your accomplishment of an objective, performance elements have performance standards to 
help determine how you accomplished your work. As mentioned earlier, the two standards can be found in the 
Resources section. 

Coach Script: 

An example of using performance elements may be helpful. Your supervisor evaluates your overall 
performance behavior for each of the six elements. For example, everyone has communication as one of his or 
her performance elements. In preparing your evaluation, your supervisor will use the communication 
performance standard for your work category and work level. He or she will use that performance standard to 
determine the rating for your communication performance element considering how you communicated 
throughout the performance period in support of accomplishing your work. 

Your supervisor would use the applicable performance standards to assign ratings for each of the remaining 
five performance elements. The ratings for your performance objectives are averaged, as are the ratings for 
your performance elements. After the averages have been determined, the performance objective average is 
weighted 60 percent, and the performance elements average is weighted 40 percent, to derive your final 
evaluation of record. This process is described more fully in the DCIPS 101 course. 
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Performance Objective Reminders 

• Performance objectives are not daily job tasks, and they go beyond position descriptions. 
• Performance objectives should be relevant to the 

organization’s mission and goals. 
• Performance objectives are written to the successful 

level of performance and are commensurate with 
your work level. 

• Best practice is to create three to six performance 
objectives, but DCIPS permits as few as one. 

• The established standards for evaluating 
performance objectives and performance elements 
can be found in the Resources section. 

• Performance elements involve desired work 
behaviors—how you accomplish your work and how 
you accomplish your objectives—and apply to all 
aspects of the job. 

• SMART is an effective framework for creating well-
written performance objectives: Specific, 
Measurable, Achievable, Relevant, and Time-
bound. 

Objectives = What + How 
 
Narrator Script: 

Let's summarize some key concepts about performance objectives: 

• Performance objectives differ from daily job tasks and activities. Performance objectives focus on 
outcomes and results. They describe future situations. 

• Performance objectives must be relevant to your organization's goals or priorities. 
• Performance objectives are written at the successful level of performance and are commensurate with 

your work level. 
• As a general guideline, use three to six performance objectives to outline the “big bucket” items you are 

expected to perform throughout the performance evaluation period. 
• Performance standards (or benchmarks) are referred to as performance descriptors that identify 

standards for the five levels of performance. Performance descriptors for performance elements are 
tied to an employee’s work category and work level. 

• Performance objectives should be written in the SMART framework. We’ll discuss that framework a 
little later in this course.  
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Getting Started: Thinking About Your Work 

 

Narrator Script: 

Welcome to the Getting Started module. In this module, we will practice breaking down your work into subsets, 
as a starting point for writing performance objectives. 

Grouping your work into categories (or big buckets) of associated tasks and activities is the first step in the 
process of writing good performance objectives. These categories serve as the basis for your performance 
objectives, since they focus on the "large buckets of work" you are expected to accomplish. Grouping your 
work into categories, or “buckets,” can be challenging. 
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Identifying Work Responsibilities 

• Think about the work you will do for the upcoming year: List all 
of your responsibilities.  

• Group your responsibilities into three to six major categories.  
• Enter three to six categories for your work in the fields below. 

 
 

• Not specific tasks  
• Major areas  

 
 

Select the coach and virtual employees icons and follow the directions on the screen. 
 
Narrator Script: 

The first step in writing performance objectives is to think about your job. What do you expect to produce, or 
accomplish, during the next evaluation period? List your responsibilities that support the mission or goal of your 
organization. 

Include all work to which you will add value. 

When finished, group these responsibilities into three to six categories. These categories will be the major 
areas where you will invest your time, energy, and talent—the foundation for your performance objectives. 

In the boxes on this screen, enter descriptions of the major categories.. You can copy and paste text from 
other documents into these fields, if desired. 

In describing these categories, do not worry about writing full sentences; rather, focus on organizing your 
activities into “What you do” categories. 

On the first line of each field, enter a brief name for that category. 
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Coach pop-up: 
 

This approach might help to clarify your thoughts. You can use your computer or even a piece of paper. We’ll 
use paper here: 

• Draw a three-column table with titles as shown below.  
• List all your projected accomplishments in the first column.  
• Review and revise your list to focus on the things you do most often. This is brainstorming. You can 

add and delete at any time.  
• Use the second column to group the responsibilities listed in the first column into three to six major 

clusters.  
• Assign each cluster a name in the third column.  

Example: 

Duties, Tasks, and Activities Clusters Major Work Categories 

 [duty/task/activity 1]  
 [duty/task/activity 2]  
 [duty/task/activity 3]  
 [duty/task/activity 4]  
 [duty/task/activity 5]  
 [duty/task/activity 6]  
 [duty/task/activity 7]  
 [duty/task/activity 8]  
 [duty/task/activity 9]  
 [duty/task/activity 10]  
 [duty/task/activity 11]  
 [duty/task/activity 12]  
 [duty/task/activity 13]  
 [duty/task/activity 14]  

 [duty/task/activity 3]  
 [duty/task/activity 6]  
 [duty/task/activity 13]  

[cluster name] 

 [duty/task/activity 14]  
 [duty/task/activity 4]  
 [duty/task/activity 8]  
 [duty/task/activity 11]  

[cluster name] 

 [duty/task/activity 2]  
 [duty/task/activity 9]  

[cluster name] 

 [duty/task/activity 10]  [cluster name] 
 [duty/task/activity 12]  
 [duty/task/activity 7]  
 [duty/task/activity 1]  

[cluster name] 

 

Virtual Employee pop-ups: 

Kyle Staten’s Categories of Work 
Kyle has broken his job into three major job categories: 

1. Investigates critical intelligence issues and trends for assigned subject area  
2. Produces intelligence products, e.g., forecasts and capabilities assessments  
3. Responds to quick-reaction tasks to provide technical and analytical information (project work)  

Vera Belrose's Categories of Work 
Vera has broken her job into three major job categories:  

1. Conducts security inspections and provides reports  
2. Develops procedures for physical security requirements  
3. Communicates with serviced organizations to bolster security preparedness  

Josh Gregor’s Categories of Work 
Josh has broken his job into three major job categories: 

1. Conducts budget formulation (out years)  
2. Performs budget administration (current year)  
3. Serves as team leader for subordinate analysts and technician 
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Translating Your Categories into Desired Results 

For each category, describe what you expect to achieve. 
Add to or edit the text, as appropriate.   

 

 
 

To help identify your achievements in each of your major categories, ask yourself these 
questions:  

• "What is important for me to accomplish in this area in the next performance year?"  
• "What is the impact of my accomplishment or why is the accomplishment important?"  
• "What would a finished work product for this category look like?"  

 
Select the coach and virtual employee icons, and follow the directions on the screen. 
 
Narrator Script: 

Now that you have identified your categories, what are you are trying to achieve in each? Does each category 
contribute to your organization’s mission? 

How would you show that you have successfully accomplished the work? For example, if one of your 
categories is "approving travel requests," your successful accomplishment might be "timely processing of all 
approved travel requests within guidelines published in the organizational travel policy." 

Use the fields on this screen to enter accomplishments for each of your categories. Again, do not get bogged 
down with writing complete sentences. There are additional opportunities to fine-tune your performance 
objectives as you proceed. 

Make sure these accomplishments aren’t individual task lists, but larger overarching categories of job duties 
and responsibilities that you’ve organized. Also, make sure you have the outcome of your major categories or 
the “so what” effect to what you’ll accomplish for the evaluation performance period. 
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VE pop-ups: 
 

Kyle Staten’s Desired Results  

1. Data gathering and analysis is robust. Info gaps are discovered and reported. Data collection 
methods are aggressive, current, forward looking. Appropriate parties are well informed.  

2. Products meet the custom needs; challenge past assumptions; are based on the most current 
methodology.  

3. Short-fuse projects are handled competently and on time within the scope set by the customer.  

Vera Belrose’s Desired Results  

1. Inspections will be thorough and follow the inspection requirements of Policy #100. Reports will be 
well written, comprehensive, and useful to the reader.  

2. Protocols and procedures will be accurate and complete, reflecting the higher command 
requirements, and will assure customer security is protected.  

3. Serviced organizations will be well informed as a result of proactive communications.  

Josh Gregor’s Desired Results 

1. Assigned program budget requests (for out-year funding) are determined and submitted in a timely 
and accurate manner and there is no break in funding.  

2. Serviced commanders are kept well informed on the status of their current year budget execution 
and ways in which they can reduce spending. Program ceilings are in place and monitored 
effectively.  

3. Team members competently analyze their budget areas of responsibility and submit accurate, timely 
reports.  
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Narrator Script: 

Welcome to the Writing Effective Performance Objectives module. This module helps you write appropriate 
and effective performance objectives using the SMART framework. SMART provides a standard for 
determining the quality and appropriateness of performance objectives. 

Incorporating the components of SMART into your performance objectives helps ensure your job performance 
is documented against mission requirements. The SMART components will also help support the evaluation of 
your accomplishments. 
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What Is SMART? 

 

Narrator Script: 

You just identified the main categories of work that encompass your job and have translated those work 
categories into tangible outcomes. 

With fine-tuning, your outcome statements will become the performance objectives that you and your 
supervisor will use to monitor and assess your performance. 

SMART stands for Specific, Measurable, Achievable, Relevant, and Time-bound. Don’t forget: the coach can 
give you additional tips to consider, and the virtual employees will show you what they have done at each step 
along the way. 

Keep in mind that “measurable” in this model pertains to impact and results. We’ll cover more information on 
this topic later. 
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As an option, begin with ”M” - Measurement 

• Look for verifiable measures to include with your objectives.  

In the space below, edit your objectives to make them Measurable. 

 
 

 
 

            

 
Select the coach and virtual employee icons, and follow the directions on the screen. 
 

Narrator Script: 

Although the acronym is S-M-A-R-T, you do not have to proceed in that order. An alternative method is to start 
with the letter M: deciding how to measure your accomplishment. 

Measurable means that there is an observable or verifiable way to assess and record the behavior, action, and 
quality that indicates or describes a successful outcome and should focus on impact and results. 

• Measurable is probably the most difficult element to incorporate into a performance objective. Many 
people believe their work cannot be measured, but it can. 

• Look for the main, measurable elements (or mission outcomes) in your work. Seek guidance from your 
Rating Official about ways you can measure your work. 

Many jobs in the Intelligence Community are knowledge-based and do not lend themselves to using strict 
counting measurements to indicate success. In those cases, focus on the outcomes that will drive mission 
accomplishment. Avoid forcing the use of numbers when they don’t make sense. 

Keep in mind that measurable equals impact and results. 
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Consider basing quality standards on existing Standard Operating Policies (SOPs) or regulations. If you do, be 
sure to identify the applicable SOP or regulation. It’s not necessary to identify every measure that applies to 
each performance objective. Reference only those that help answer "How will I know if I accomplished my 
performance objectives?" Or, “How will I be able to measure the impact of my accomplishment?” Keep in mind 
that the quality measurement may be expressed as a narrative statement such as “Customer responses 
indicated the product met their needs.” 

Your performance objective should describe an acceptable measure of completeness. Let’s think about an 
example. If your performance objective is currently “analyze and prioritize incoming message traffic and write, 
edit and release summary reports,” you do not have a way to measure success or mission impact. However, if 
we rewrite this example to state “independently analyzes and prioritizes message traffic and issues 
comprehensive summary reports that meet customer requirements, as determined by customer” then we have 
a way to assess success. We also see that the objective has focused on the mission impact, i.e., help 
customers with their information collection needs and add value and essential results to the mission. 

If you can use quantifiable measures such as percentages, that method of measurement is acceptable. Just 
remember, your result should be meaningful. Don’t use numbers or percentages if they don’t make sense and 
if they don’t clearly convey what is needed. In general, don’t count just for the sake of counting. 

It is important to remember that your performance objectives should be written to reflect "successful" 
performance commensurate with your work level. To view the performance objectives descriptor, select View 
Objective Descriptor. 

As you write your performance objectives, keep in mind that at the end of the performance evaluation period, 
your performance elements will be evaluated along with the performance objectives. It might be helpful to look 
ahead and anticipate how you will be able to address performance elements as well as your accomplishments 
on the individual performance objectives. 

Coach Script: 

Any of these sentences can help you measure the impact and results by which your performance objective will 
be evaluated. These sentences might make it easier for you to describe your performance objective. Simply fill 
in the blanks with your specific information. 

Remember: Even though objectives describe, in general terms, what successful performance results and 
impact looks like, you and your supervisor must address the specific measurements that determine successful 
performance for each performance objective. 

Make sure that your measures, that is, your expected results and impact, are reasonable. Use metrics only 
when practical and meaningful and when they clearly reveal success and mission impact. More often you will 
use quality measurements. Having a clear understanding of expectations removes surprises when you get to 
the evaluation process. 
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Coach pop-up: 

Simply fill in the blanks with your specific information: 
These performance objectives will be measured in terms of ____, ___, and ____. 
or 
Performance objective will be measured consistent with ______. 
or 
"I can tell if this 'quality' result was accomplished when I see or know that…." 
or 
Metrics that will be used to evaluate this performance objective include ______.  

  
Virtual Employee pop-ups: 

How Kyle Staten Addressed "M" 

1. Obj #1: Data gathering and analysis is robust. Information gaps are discovered and reported. Data 
collection methods are aggressive, current, forward looking. Appropriate parties are well informed.  

2. Obj #2: Products meet the customer needs, challenge past assumptions, and are based on the most 
current methodology.  

3. Obj #3: Short-fuse projects are handled competently and on time within the scope set by the 
customer.  

How Vera Belrose Addressed "M" 

1. Obj #1: Inspections comply with Policy #100. Reports are completed in correct final form and reflect 
a thorough inspection.  

2. Obj #2: Procedures comply with higher command requirements and are correctly and appropriatly 
interpreted for the operational level.  

3. Obj #3: Serviced organizations are well informed on policy, security requirements, and issues.  

How Josh Gregor Addressed "M" 

1. Obj #1: Budget formulations for out years are established in concert with commanders’ and 
directors’ known and expected requirements. Department guidance is followed in budget 
submissions. Budget submissions will be well supported so that continuity of mission operations, 
including mission growth, in the coming years is assured.  

2. Obj #2: Monitors current year budget administration, including all commitments, obligations, and 
disbursements. Budget analysis is thorough and compliant with all regulatory requirements. 
Commanders are well informed, enabling them to manage their mission with financial certainty. Bills 
are paid on time.  

3. Obj #3: Advice and assistance to team members is timely, valid, and reliable. Workload within the 
team is distributed in a balanced and equitable manner based on skill sets. Work processes are 
improved through team collaboration throughout the year. Proactively assists junior team members 
in building skill strength.  
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Include “A” - Achievable 

Ensure that your performance objectives are achievable:  

• Is it appropriate for your experience, skill, work level and 
position?  

• Do they consider the available resources, personnel, and 
time?  

• Are they within your control to complete? Do not include work or goals over which you have no control.  

Enter words in the fields below to address accomplishing the work at the "successful" level.  

 
 

 
 
Select the coach and virtual employee icons and follow the directions on the screen. 
 
Narrator Script: 

Now you need to determine if your performance objectives are achievable. Ask yourself: Are they realistic? Are 
they within your control? Are they appropriate for your experience, skill, and work level? Are they appropriate 
to your position? Is there flexibility in case something goes wrong? For example, a measurement of 100 
percent leaves no room to exceed expectations. Or, a single mistake over the year might mean failure. 
Alternatively, is a percentage of failure acceptable? If not, reconsider the measure. 

Revise your measurements so they are achievable and appropriate to the work. Listen to the coach or take a 
look at the virtual employees for some ideas on language to use. 
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Coach Script: 

Here are some examples of performance objectives with achievable measurements included: 

Objective with quality measure: Produce a current intelligence analysis for counter-anti-terrorism leaders and 
coalition partners. Products should meet the Intelligence Community Directive #203 standards and be in 
accordance with the request received, as determined by supervisor review. 

Objective with time measure: Counter-intelligence products will be produced within 48 hours of request. 

These examples show two different ways that measurements can be added to an objective. The choice 
depends on what is important to accomplishing the objective. 

Coach pop-up: 

• Can you achieve the objective with the available resources and personnel and within the given time?  
• Is the work in the performance objective within your control to complete?  
• Is this performance objective appropriate for this work level?  
• Is the performance objective written at Level 3 (Successful)?  

VE pop-ups: 

 
How Kyle Staten Addressed "A" 

1. Obj #1: Data gathering and analysis is robust within the assigned area of expertise. Data collection 
methods include the customary as well as newly emerging methods. Focus includes expanding the 
current body of knowledge as well as discovering gaps in existing body of knowledge. Information is 
shared with all parties who will be affected by the collected information.  

2. Obj #2: Products will be tailored to the customer needs in consultation with the customers. Reports 
will show thorough analysis of existing body of information as well as exploration of new material 
and challenges to previous assumptions. Hypotheses and methods of testing will be coordinated 
with customers and will be based on sound scientific principles of validity testing.  

3. Obj #3: Short-fuse projects will be conducted in compliance with the terms set with the customer. All 
projects will reflect an understanding of the customer’s needs, competent analysis, reporting, and 
communications.  

How Vera Belrose Addressed "A" 

1. Obj #1: Throughout the rating cycle, works with mentor/senior analysts to conduct inspections in 
compliance with Policy #100. Reports are reviewed by higher-level specialists and through minimal 
coaching, are completed in correct final form, and reflect that a thorough inspection was conducted.  

2. Obj #2: Drafts procedures for operational level that comply fully with higher command requirements. 
Senior analyst will assist in clarifying the command requirements and fine-tuning the procedures, as 
needed. Drafts should not require more than one or two rewrites after senior analyst review.  

3. Obj #3: Serviced organizations are well informed on policy and security requirements and issues. 
Training classes will be observed by senior specialist, to assist in improving class delivery. 
Newsletters and other written publications will be reviewed by senior analyst before being finalized.  
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How Josh Gregor Addressed "A" 

1. Obj #1: Works independently; final products are reviewed by comptroller before submission to 
higher headquarters.  

2. Obj #2: Uses existing technology to analyze budget administration. Final products are submitted 
directly to serviced commander’s budget representatives.  

3. Obj #3: Team members are formally trained.  
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Include “R” - Relevant 

Part 1: How Does Your Work Help the Organization?  

• What are your organization's goals and priorities?  
• Enter your organization's missions or goals below.  

 
 

If you don't know your organization's goals and priorities:  

• Check your organization's website or  
• Speak with your supervisor and ask for a copy of your organization’s mission and 

functions statements.  

 
Select the virtual employee icons and follow the directions on the screen. 
 

Narrator Script: 

Your performance objectives and those of  your supervisor and organization should all focus on the same 
target. A straight "line of sight" should be discerned from the work you do and your objectives, all the way to 
the organization's objectives. Relevant means that your performance objectives connect to organizational 
goals. 

DCIPS performance objectives derive from the Defense Intelligence Strategy, the National Intelligence 
Strategy (NIS), and the mission objectives of your organization and work unit. 

Your organization’s mission and function statement—and other strategic and project planning documents—
provide the context for the work you do and its relationship to the greater DoD mission. Periodically reviewing 
these documents can help you ensure your alignment to mission success. 

What are your organization’s goals and priorities? Type or paste them in the box provided. 

As you write your performance objectives, remember that performance elements will also be assessed at the 
end of the performance evaluation period. Keep that in mind, so that you will be able to cover those aspects 
when you write your self-report at the close of the performance evaluation period. 
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Virtual Employee pop-ups: 
 

Kyle Staton 

Kyle is an intelligence analyst who is responsible for producing finished scientific and technical intelligence 
products. His products include forecasts and overall capabilities assessments for a difficult intelligence subject 
that represents a substantive area of the organization’s overall intelligence mission. 

Vera Belrose 

Vera works in a Security Operations Division at Base ABC. Her division is concerned with the physical 
protection of sensitive or classified information, personnel, facilities, installations, and processes against 
criminal, terrorist, or hostile intelligence activities. Her division provides security operational services to her 
base commander and directors and to a number of tenant organizations on the base. Vera is in a 
developmental assignment and will be eligible for non-competitive promotion to GG-11 after meeting her 
training and development goals. Overall assignments in her position are substantially the same as the GG-11 
position, but with closer supervision and assignments that prepare her to gain the knowledge and skills needed 
to be promoted to the full performance level of GG-11. 

Josh Gregor 

Josh is the budget analyst/team leader over the OMA Division within his organization. He reports to a 
comptroller (military officer) who has broad, overall budget responsibilities. Josh leads a team of three analysts 
and one technician, all of whom work exclusively with specific OMA budgets. His organization provides 
services to the base commander as well as several tenant organizations. 
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Make it “R” – Relevant 

Part 2: Editing Your Outcomes for Relevancy to Your Organization's 
Goals  

• For each objective, what tells reviewers the relevance to your 
organization's goals?  

• To help reviewers see the relevance of your objectives to the organization's goals, review the goals 
again and address how your activities will help accomplish them.  

 
 

 
 
 
Select the coach and virtual employee icons and follow the directions on the screen. 
 
Narrator Script: 

Take a moment to review your own outcomes and work priorities. Are they relevant to your organization’s 
goals? Do they support mission accomplishment? If they aren’t relevant, or if they could be better aligned, edit 
your statements in the fields provided. 

For example, if your performance objective outcome is "prepare 98% of logistics supply orders in compliance 
with the department regulations within one day of receipt of requisition" you could link this to the organizational 
goal of "Increasing the volume of requisitions filed on time" by saying, "This supports our organization’s goal of 
increasing the volume of requisitions filed on time by 15 percent by the end of the year." 

In some cases, you may be able to link your work to the agency level goals or those of the intelligence 
community at large. The important thing to remember is to show your connection to mission accomplishment. 

Listen to the coach or take a look at the virtual employees for some ideas on how to link your outcomes to your 
organization's goals 
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Coach pop-up: 

Here's how to link the performance objective to your organization's goals:  

• Start with a sentence or a phrase that repeats the specific mission. Begin with the words "To help my 
organization...," and then add the specific organizational goal and finish with your performance 
objective outcome. 
 
For example, "To help my organization stay within fiscal bounds" or "To help my organization respond 
quickly to customer requests..."  

Virtual Employee pop-ups: 

How Kyle Staten Addressed "R” 

1. Obj #1: To help my organization build a body of highly reliable scientific and technical information…..  

2. Obj #2: To help my organization provide cutting-edge S&T Intel products….  

3. Obj #3: To provide quick-reaction service to our customers, ….  

How Vera Belrose Addressed "R" 

1. Obj #1: To discover and address security vulnerabilities, in compliance with the HQ Directive policy 
#100… 

2. Obj #2: To stay current with higher command security regulations, operational regulations will….  

3. Obj #3: To help serviced organizations stay well informed…..  

How Josh Gregor Addressed "R" 

1. Obj #1: To meet the mission strategic goal to ensure sound financial basis for coming budget 
years…..  

2. Obj #2: To keep serviced commanders and directors on track in managing their current-year 
budgets and informed on ways to reduce costs…….  

3. Obj #3: To maintain a high-functioning team that requires no intervention by the comptroller……  
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Add ”S” - Specific 

• Do your performance objectives describe an observable action, 
behavior, or achievement?  

• Edit your objectives to make them more Specific. 

 
 

•  Be specific about the results, not the activities  

 
 

 
Select the coach and virtual employee icons and follow the directions on the screen. 
 
Narrator Script: 

Similar to measurable, “specific” makes you envision the final outcome of your work. By including exactly what 
is expected of you and the impact your success will have on the mission, you and your supervisor gain a 
shared understanding about what is to be achieved. 

For example, if your task/activity is “type all correspondence effectively,” a specific result could be, “format all 
correspondence to comply with the department style guide for formatting, grammar, and usage as determined 
by managerial review." 

Take a look at your performance objectives and, if necessary, determine what a clearer, more specific 
description of what your results will look like. 

Identifying the specific accomplishment also means pinpointing your role. What actions, behaviors, or 
achievements are your responsibility? Carefully choose terms to accurately describe your role in group 
projects. The description of your role should not replace the result in the performance objective; it should only 
provide additional detail. 
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Coach Script: 

Specificity is often threaded throughout a performance objective. If thinking of "specific" gives you trouble, 
consider thinking of this guideline as "specific result." What does the outcome look like? Consider “why is this 
specific impact important?” Specific differs from measurable in that measurable is concerned with assessing 
observable or verifiable outcomes. Specific focuses on providing enough detail to prevent misunderstandings 
about what the end product will look like. 

For example, if your performance objective is to update a policy manual, it is not enough to say that the result 
is to have an updated policy manual. You would ask yourself these types of questions: 

• Which manual? 
• What do we mean by update? 
• How much of the manual will be updated? and 
• Updates should be current as of when? 

Virtual Employee pop-ups: 

How Kyle Staten Addressed "S" 

1. Obj #1: In support of the organization’s mission to provide scientific and technical information, data 
gathering and analysis is robust and can withstand challenge within the assigned area of expertise. 
Data collection methods include the customary as well as newly-emerging scientific and technical 
methods. Focus includes expanding the current body of knowledge as well as discovering gaps in 
existing body of knowledge. Information is shared with all parties who will be affected by the 
collected information. Products are accepted as technically sound and high value by superiors and 
subject matter experts working in the field.  

2. Obj #2: To provide supported organizations with steady, ongoing, reliable information, products will 
be tailored to the supported organizations in consultation with the customers. Reports will show 
thorough analysis of existing body of information as well as exploration of new material and 
challenges to previous assumptions. Hypotheses and methods of testing will be coordinated with 
customers and will be based on sound scientific principles of validity testing. Work will result in 
products that are reported to be reliable, helpful, and useful to the end users.  

3. Obj #3: To be of high value to urgent, short-fuse customer requirements or one-time projects will be 
conducted in compliance with the terms set with the customer. All projects will reflect an 
understanding of the customer’s needs, competent analysis, reporting, and communications. 
Finished products will be accepted by the customer on first submission, unless customer 
requirements have changed. 

How Vera Belrose Addressed "S" 

1. Obj #1. To discover and address security vulnerabilities, in compliance with the HQ Directive policy 
#100, all inspections will be conducted following the requirements contained in the policy. 
Inspections will include (as stipulated in Policy #100): creation of a thorough pre-inspection 
document that complies with the policy; formal coordinating with inspection site; actual conduct of 
inspection with completed check sheets; reports issued to inspected party and higher command. 
Pre-inspection, inspection, and reports will comply with the requirements of policy #100; will show a 
good understanding of the security requirements contained in the policy, and will require minimal 
change by senior analysts. Senior analysts will assist in planning work, executing the inspections 
and reviewing inspection reports.  
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2. Obj #2: Assists operational level organizations stay current with higher command security 
regulations by preparing operational regulations. Draft procedures will be reviewed by senior analyst 
before finalization. First drafts will capture the key points of higher-level regulations and will show 
conformance with those higher-command requirements. Senior analyst will assist in clarifying the 
command requirements and fine-tuning the procedures, as needed. Drafts should not require more 
than one or two rewrites after senior analyst review.  

3. Obj #3: To help serviced organizations stay well informed, formal training will be conducted as 
required by higher command policy. 100% of all serviced organizations will be trained. Training 
classes will be observed by senior specialist to assist in improving class delivery. The evaluations of 
the training classes will show that training objectives were met. Security newsletters and other 
written publications will be well written and informative and will show the latest information from 
higher-level commands. Written publications will be reviewed by senior analyst before being 
finalized and should require only one rewrite per document.  

How Josh Gregor Addressed "S" 

1. Obj #1. Working independently, budget formulations are established in concert with commanders’ 
and directors’ requirements for the coming years. Department guidance is followed in budget 
submissions. Budgets will be created for five out years, with valid and reliable supporting 
documentation for each submission. Budgets should rarely be returned from the comptroller for lack 
of sufficient support. Budget submissions will be well-supported so that continuity of mission 
operations, including mission growth in the coming years, is assured.  

2. Obj #2: To keep serviced commanders and directors on track in managing their current-year 
budgets and informed on ways to reduce costs, individual organization budgets (including all 
commitments, obligations, and disbursements) are thoroughly tracked using department automation 
tracking systems. Budget analysis reflects a sound understanding of the serviced organizations’ 
missions and anticipated spending requirements as well as knowledge of fiscal reporting systems. 
Cost reduction proposals are realistic and result in potential savings of 5 to 10% of total budget, if 
adopted. Budget analysis is compliant with all regulatory requirements. Commanders are well 
informed, enabling them to manage their mission with financial certainty. All bills are paid in 
sufficient time that no interest is accrued.  

3. Obj #3: To maintain a high functioning team that requires no intervention by the comptroller, advice 
and assistance to team members is timely, valid, and reliable. Products submitted by the team are 
correct and comply with governing regulations. Individual budget analyses rarely need to be 
reworked as a result of errors found by the team leader. Workload within the team is distributed in a 
balanced and equitable manner based on skill sets. Work processes are improved through team 
collaboration throughout the year. Proactively assists junior team members in building skill strength.  
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Finish it with “T” - Time-bound 

• Specify when you will accomplish your result.  
• Modify your objectives to make them Time-bound.  

 

 
 

•  Avoid relative descriptions of time such as "in six months" or "by next Friday".  

 
 

 
Select the coach and virtual employee icons and follow the directions on the screen. 
 

Narrator Script: 

When identifying time frames, only consider work you can accomplish within the performance period. If you’re 
working on a multi-year project, consider what parts are reasonable to accomplish within the performance 
evaluation period and include this in your time frame. Depending on your work, you may want to include 
milestones throughout the year. 

If your work is ongoing but specific progress or accomplishments can be completed during the performance 
period, consider specifying the time as “by the end of the performance cycle.” 

When you have determined the performance time frame for your performance objective, revise your 
performance objectives by adding an accurate description exactly how they are time bound. 

If you select the virtual employee icons on this screen, you will see their complete performance objective with 
all of the S-M-A-R-T components combined. Each component will be identified within the objective. 
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Coach Script: 

When feasible, avoid using relative descriptions of time (for example, "in six months"). Specific time frames 
such as by a certain date (June 30 or August 31) are more precise. 

You can use a variety of sentence structures to help you insert a time frame into your performance objectives. 

By the way, if you know at the beginning of the year that a significant portion of your assignments are 
frequently last minute or driven by external requests, you can still create performance objectives that are 
SMART. A performance objective for such work may be phrased as "Throughout the performance year and in 
support of organizational goals, action items are completed within the time frame agreed to at the time of 
assignment and in accordance with quality standards described by the supervisor." 

Coach pop-up: 

You can use a variety of sentence structures to help you insert a time frame into your performance objectives. 
Simply fill in the blanks in these sentences:  
The objective should be achieved / attained no later than ______.  
or  
The anticipated completion date is ______.  
or  
Milestones for completing this objective are ______, _____ and ______. or  
By ______________, or Throughout the performance period, ______.  

Virtual Employee pop-ups: 

How Kyle Staten Addressed "T" 

1. Obj #1: In support of the organization’s mission to provide scientific and technical information to field 
users (R), data gathering and analysis is robust and can withstand challenge within the assigned area 
of expertise (M). Data collection methods include the customary as well as newly-emerging scientific 
and technical methods (S)(A). Focus includes expanding the current body of knowledge as well as 
discovering gaps in existing body of knowledge (S). Products are accepted as technically sound and 
high value by superiors and subject matter experts (M). Work is ongoing throughout the evaluation 
period (T). Specific time frames may be established with the supervisor as demand from the field 
dictates (T). 

2. Obj #2: To provide supported organizations with steady, ongoing, reliable information (R), products will 
be tailored to the supported organizations in consultation with the customers (A)(M). Consultation will 
be held routinely to make sure the on-going analyses (T) are supporting their requirements (S). Reports 
will show thorough analysis of existing body of information as well as exploration of new material and 
challenges to previous assumptions (S). Hypotheses and methods of testing will be coordinated with 
customers (R) (A) and will be based on sound scientific principles (M) of validity testing. Work will result 
in products that are reported to be reliable, helpful, and useful to the end users (M).  

3. Obj #3: To be of high value to customers (R), urgent, short-fuse requirements or one-time projects will 
be conducted in compliance with the terms set with the customer (S) (M). Meetings will be held with 
customers (A) on one-time projects within two workdays (T) after receipt of the request. All completed 
projects will reflect an understanding of the customer’s needs, competent analysis, reporting, and 
communications (M). Finished products will be submitted on schedule (T) negotiated with the customer 
and will be found acceptable to the customer on first submission (M) unless customer requirements 
have changed.  
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How Vera Belrose Addressed "T" 

1. Obj #1: To discover and address security vulnerabilities (R), in compliance with the HQ Directive policy 
#100, (M) all inspections will be conducted following the requirements contained in the policy (S). Each 
serviced organization will be inspected annually (T). Pre-inspection, inspection, and reports will comply 
with the requirements of policy #100 (M); will show a good understanding of the security requirements 
contained in the policy (M); and will require minimal change by senior analysts (M). Pre-inspection 
plans will be completed NLT 30 days before the start of inspection (T); inspections will be completed 
within time negotiated with the serviced organization (T); inspection reports will be submitted NLT 10 
days after close of inspection (T). Senior analysts will assist in planning work, executing the 
inspections, and reviewing inspection reports. (A)  

2. Obj #2: Assists operational level organizations stay current with higher-command security regulations 
(R) by preparing operational regulations (S). Draft procedures will be submitted to senior analyst for 
review within the prescribed time frame established with the senior analyst (T) (A). First drafts will 
capture the key points of higher-level regulations and will conform with those higher-command 
requirements (M). Senior analyst will assist in clarifying the command requirements and fine-tuning the 
procedures, as needed (A). Drafts should not require more than one or two rewrites after senior analyst 
review. (M)  

3. Obj #3: To help serviced organizations stay well informed (R), formal training will be conducted on 
annually (T) as required by higher-command policy (S)(M). 100% of all serviced organizations will be 
trained (M). Training classes will be observed by senior specialist to assist in improving class delivery 
(A). The evaluations of the training classes will show that training objectives were met (M). Security 
newsletters and other written publications will be well written and informative and will show the latest 
information from higher-level commands (M). Security newsletters will be published at least quarterly 
(T); other publications will be published on a timeline established with supervisor or senior analyst (T). 
Written publications will be reviewed by senior analyst (A) before being finalized and should require 
only one rewrite per document (M).  

How Josh Gregor Addressed "T" 

1. Obj #1: Budget formulations are established based on commanders’ and directors’ requirements for the 
coming years (A) (S). Department guidance is followed in budget submissions (M). Timelines will be 
established by higher headquarters each year; all timelines will be met (T). No timeline extensions will 
be requested due to lack of planning or preparation (M). Budgets will be created for five out years, with 
valid and reliable supporting documentation for each submission (M). Budgets should rarely be 
returned from the comptroller for lack of sufficient support (M). Budget submissions will be well 
supported so that continuity of mission operations, including mission growth, in the coming years is 
assured (R). This objective supports the mission strategic goal to ensure sound financial basis for 
coming budget years (R).  

2. Obj #2: To keep serviced commanders and directors on track in managing their current year budgets 
(R), individual organization budgets (including all commitments, obligations and disbursements) are 
thoroughly tracked (S) (M) using department automation tracking systems (A). Budget status reports 
are submitted to serviced commanders and directors within ten days after close of the fiscal quarter (T). 
Each quarter (T), meetings will be held with commanders and directors to share budget information and 
cost reduction proposals and to gather information for future analyses (S). Cost reduction proposals are 
realistic and result in potential savings of 5 to 10% of total budget, if adopted (M). Budget analysis 
reflects a sound understanding of the serviced organizations’ missions (R) and anticipated spending 
requirements as well as knowledge of fiscal reporting systems. Budget analysis is compliant with all 
regulatory requirements (M). Commanders are well informed, enabling them to manage their mission 
with financial certainty and to cut costs where appropriate (R). All bills are paid in sufficient time that no 
interest is accrued (M).  
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3. Obj #3: To maintain a high functioning team (R) that requires no intervention by the comptroller, advice 
and assistance to team members is timely, valid, and reliable (S) (M). Products submitted by the team 
are correct and compliant with governing regulations (M). Individual budget analyses are submitted by 
team members on pre-established time frames (T) and rarely need to be reworked (M) as a result of 
errors found by the team leader. Workload within the team is distributed in a balanced and equitable 
manner based on skill sets (A). Process improvement meetings (S) are held quarterly within the team 
(T). 
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Taking a Final Look 

• Can you see the link between your performance objectives and your organization’s mission and goals?  
• Are your performance objectives focused on three to six priorities (categories)?  
• Are your performance objectives focused on results?  
• Are your performance objectives appropriate for your work level?  
• Have your performance objectives incorporated the SMART criteria?  

 
 

•  Discuss your performance objectives with your supervisor. 

 

Remember: These performance objectives are just the starting point. You and your supervisor still need to 
talk about them and reach a shared understanding. You might need to adjust your performance objectives 
as a result of the discussion. 

Select the coach icon and follow the directions on the screen. 
 
Narrator Script: 

Before you finish, do a final check of your performance objectives by answering the following questions: 

• Can you identify how your performance objectives align with your organization’s mission and goals? 
• Are your performance objectives focused on results? 
• Are your performance objectives focused on the three to six major categories or priorities that make up 

your job? 
• Are your performance objectives appropriate for your work level? That is, if you are in the Full 

Performance work level, are your objectives written at that level? 
• Have you addressed all of the SMART criteria for each performance objective? 

If the answer to any of these questions is no, revise your performance objectives in the fields on this screen. 
Remember that these draft performance objectives are the starting point for your discussion with your 
supervisor to finalize your performance plan. Your input is key. 

As you meet with your supervisor to review your performance objectives, expect some fine-tuning. The 
purpose of this exchange is to make sure you and your supervisor are on the same page so that you can 
proceed through the year with the same frame of reference. 
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Coach Script: 

Your Rating Official, typically your supervisor, must ensure that your performance objectives serve your 
organization’s goals and are appropriate for your position. Therefore, your supervisor and you need to discuss 
your draft performance objectives. 

Your supervisor may adjust your performance objectives to be more specific and may discuss with you other 
aspects of your organization that you may not have considered. 

Just remember, performance objectives cannot be used in your performance evaluation unless they have been 
in place for 90 days. Finalizing your performance objectives helps ensure that your supervisor and you have a 
shared understanding about what is expected of you. 
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Narrator Script: 

Welcome to the Writing a Self-Report of Accomplishments module. In this lesson, you will cover self-
assessments that you will normally write near the end of the performance period. 

An important input to the DCIPS performance management system is your own Self-Report of 
Accomplishments. Who could be more informed about what you did in your job than you? 

This Self-Report of Accomplishments is a primary reference for your Rating Official, who will use your self-
report, along with his or her own observations in preparing your performance evaluation. It is your chance to 
tell your Rating Official what you did and how well you did it. It is critical that you present a complete and 
accurate picture of your accomplishments over the performance period. 

To help you write your Self-Report of Accomplishments, this module introduces, and allows you to practice 
with, the STAR approach. 
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The STAR Approach 

 
 
Select the coach icon and then select Next. 

Narrator Script: 

Performance objectives describe a future state—what you are expected to achieve. A Self-Report of 
Accomplishments focuses on what you have achieved. 

Under DCIPS, you have the opportunity to provide your Self-Report of Accomplishments as part of the 
midpoint review and end-of-year performance evaluation. To help you get some practice, we suggest that you 
try to write a Self-Report of Accomplishments in iSuccess. Because you know your work better than anyone 
else, you must write your Self-Report of Accomplishments. This activity is your chance to highlight your 
accomplishments and point out how they contributed to the achievement of your organization’s goals. 

When you need to explain the significance of your contributions, the STAR approach is one that can help: 

• S stands for Situation: Describe the conditions under which you achieved your performance objectives. 
If you had short timelines or changing demands and you were still able to complete your work 
satisfactorily, point that out. 

• T stands for Task: Describe what you did during the year to create the results you achieved. 
• A stands for Activity: Include any additional activities you completed that contributed to your results. 
• And R stands for Result: Describe the importance of your accomplishments and how they affected the 

results.. Be specific. Don’t leave it to others to presume your contribution. If you saved money, if you 
saved time, if you prevented waste, if you think you exceeded the expectations for the objective, say so 
and explain how.  
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Coach Script: 

A key to writing effective performance objectives is to start with the end in mind. When a well-written 
performance objective is successfully accomplished, it translates easily into a well-written Self-Report of 
Accomplishments. Therefore, thinking about your Self-Report of Accomplishments at the beginning of the 
process can help you sharpen your performance objectives and make writing this report easier. 
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Projecting What Success Looks Like 

• Write a Self-Report of Accomplishments for each of your 
performance objectives in the fields below.  

 

 
 

  

 
 

 
Select the coach and virtual employee icons and follow the directions on the screen. 
 
Narrator Script: 

A good way to check your progress towards meeting your performance objectives is to visualize a description 
of your accomplishments throughout the performance period. Keep your envisioned writeup handy. Add to it as 
the year progresses to give yourself an idea of how your performance measures up and to identify how you 
might enhance your performance against the performance objectives and performance elements. Include your 
performance elements in your visualized description of your performance. 

In the space provided, write your Self-Report of Accomplishments for each of the performance objectives you 
created. If you want to see your performance objectives, select the link in the text on the screen. If you need to 
view the performance objectives descriptors, select Resources. 

 
Coach pop-up: 
 
Remember to do the following when writing a Self-Report of Accomplishments:  

• Highlight your most significant achievements for the performance period.  
• Include language from the objectives descriptor in your description of your accomplishments against 

the performance objectives. You will find the objectives descriptors in the Resources section. 
• Connect what you did to how it contributed to the achievement of your organization’s mission and 

goals. Show results and impact of your performance.  
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Virtual Employee pop-ups: 

How Kyle Staten Applied STAR to a Self-Report  

1. During the performance period, I provided scientific and technical information to 125 field units. I collected 
this information using conventional methods developed over the last decade. I also developed a field of 
new sources for information that added to the value of the information I provided. In addition, I developed a 
scientific strategy to confirm the validity of the new source information. That strategy has been exported 
throughout the Intelligence Community (IC). When needed, I engaged and collaborated with other 
intelligence professions in the IC to ensure accuracy of my products. The quality of my work was accepted 
by the management team and by peer review. As a result of my work, field units were able to expand their 
body of knowledge in ways that could not have been otherwise possible. This assisted them in making 
timely, well-informed decisions about their operations.  

2. I helped 50 field units close information gaps by researching and discovering information they should 
consider that went beyond their original request. In all 50 cases, the response to my broadened approach 
was overwhelmingly positive. In March of this year, I received two commander’s awards for the value of the 
information I provided to their units. In all cases, the information I provided was found to be reliable and 
valid. No reports were rejected because they lacked relevancy or sufficiency.  

3. Throughout the performance period, I routinely and often received short-fuse projects for serviced 
customers. Most short-fuse projects entailed verifying information through scientific methods. In each case, 
I communicated closely with the customer and negotiated both the outcomes of the projects and the time 
frames with the customers. In all projects, I used the most up-to-date scientific analysis methods, and my 
results were confirmed through replication. All projects were completed on time with positive feedback 
received from the units requesting the projects. My work enabled the customers to meet their intelligence 
verification needs with minimal disruption to their work flow.  

How Vera Belrose Applied STAR to a Self-Report  

1. I conducted five security inspections, with oversight by the senior analyst. My senior analyst and the 
inspected commander’s executive staffs reviewed the results of my inspections. All parties found that I 
followed the spirit and intent of HQ Directive policy #100 in executing my inspections. My pre-inspection 
plans were consistently completed earlier than 30 days before the start of the inspection; my post-
inspection reports were always written within the allotted ten days after the close of the inspection. My 
inspections helped organizations find and correct weaknesses in their security operations.  

2. I reviewed the local security operations regulation and drafted a proposed update to the regulation. My 
proposal included new information I pulled from recently released higher HQ regulations. After the senior 
analyst review, I revised my first draft. It was accepted on the second review. The new security regulation 
has been approved and is now being used in the field. My work will help serviced organizations stay 
current with the latest security requirements.  

3. I conducted 25 annual security awareness briefings, as required by higher headquarters. 100 percent of 
the serviced organizations received the training. My senior analyst observed the first five sessions and 
found that I could handle the rest without oversight. My course evaluations were always at or above the 
midpoint for training content and delivery. Also, I wrote one newsletter each quarter. My written publications 
are rarely returned for editing by the senior analyst. My work has helped keep the serviced population well 
informed.  
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How Josh Gregor Applied STAR to a Self-Report  

1. During the rating cycle, I was responsible for preparing budget requests for the next five years on behalf of 
the base commander and five tenant commanders. To be sure my budget requests had the best chance of 
approval, I collected forecast information by interviewing the commanders and their key staffs. Together, 
we explored mission change and growth demands that will influence the forecasts. Working with the 
commanders, I prepared original budgets, presented briefings to them regarding the budget proposals, and 
received approval on all budgets after the first briefing. No changes were made to any of my budget 
forecasts as a result of failure to account for current or emerging fiscal demands. All six of the budget 
forecasts were prepared, approved, and submitted to higher HQ within the prescribed time frames. By 
submitting thorough, on-time budget predictions for the coming years, the serviced organizations will 
receive sufficient funding, subject to availability of funds, to ensure continuity of operations for the coming 
years.  

2. My responsibilities include budget execution oversight. To help organizations stay within their execution 
ceilings, I prepared quarterly budget status reports. Each of these reports was completed earlier than the 
ten-day deadline after close of the quarter and contained detailed analysis of all Elements of Spending. I 
established rapport with the key serviced organizations and visited them to deliver the budget reports. 
These efforts kept the lines of communication open, so I could anticipate any emerging problems. I was 
able to recommend to two major serviced organizations (X and Y) ways in which they can reduce their 
spending through budget control, by up to 10 percent. I recommended budget savings up to five percent for 
the remaining four major organizations. All bills were paid on time and no interest was accrued due to late 
payment.  

3. In leading my team this year, I put in place a process improvement program. This program resulted in 
recommendations (which were adopted) to streamline our internal automated tracking system and ways in 
which we can increase our visibility and communications with our customers. All members of my team have 
IDPs in place and are on track to complete them this year. The work of the senior analysts is consistently 
high, with very positive feedback from their customers. Our technician is a strong team member who 
provides reliable and valid feeder reports to the senior analysts. Keeping this team strong and high 
performing assists the comptroller with the overall management of the organization.  
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Guidelines for Writing a Self-Report of 
Accomplishments 

• Restate your understanding of your performance 
objectives. 

• Highlight your most significant achievements for 
the appraisal period. 

• Connect what you did with why it matters to your 
organization. 

• Note challenges you faced and how you fared. 
• Address each performance objective individually in 

your Self-Report of Accomplishments. 

 
 
 
 
 
Narrator Script: 

When writing your Self-Report of Accomplishments, the following guidelines may help: 

• Highlight your most significant achievements for the performance period. To begin, you may want to list 
every achievement, small or large. But remember, a Self-Report of Accomplishments is not a report of 
daily work activities. Instead, stick with what you believe mattered most. Consider impact and results 
and specific things supporting your performance objective. 

• Connect what you did with the importance to your organization’s mission. Highlight how your 
organization has benefited from your contribution by describing tangible benefits, such as cost savings 
to the organization or a solution that enables employees to perform better. 

• Be sure to highlight specific instances in which your actions and accomplishments made a positive 
difference in the outcome of a performance objective. 

• Overcoming challenges is an important part of your overall performance. Note challenges you faced 
and how you fared. 

• For the purpose of checking your performance objectives and for subsequent comprehension, it helps 
to address each objective. Even when you write the full Self-Report of Accomplishments, you should 
make sure to discuss every performance objective and its related accomplishments. 
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Comparing Accomplishments to Objectives 

• Compare your Self-Report of Accomplishments against the standards for performance objectives and 
performance elements at your appropriate work category and work level. You will find the IC 
Performance Standards and the DoDI 1400.25 Volume 2011, Performance Management, in the 
Resources section. 

• Compare how you described your accomplishments against your performance objectives.  
• Is your accomplishment more specific than the performance objective? If so, revise your performance 

objectives to be more specific (performance objectives can only be changed if there is at least 90 days 
left in the performance evaluation period.)  

 
 

•  Be specific and concise. 

 
 

 
Select the coach icon and follow the directions on the screen. 

Narrator Script: 

Use this screen to compare your accomplishments to your performance objectives, considering the guidelines 
we just discussed. 

Do you need to make your performance objectives more specific? If so, use these fields to revise your 
performance objectives. 

Coach Script: 

A key to writing a good Self-Report of Accomplishments is to describe the main points in a brief manner. 
Although you might be tempted to write a multi-page description, your Self-Report of Accomplishments will be 
more effective if it is specific, concise, and focused on outcome. 
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Addressing the Performance Elements 

 
 

 
 

 
• Be specific and concise and use STAR when appropriate. 

 
 

 
 
Select the coach icon and follow the directions on the screen. 

Narrator Script: 

You now have a draft Self-Report of Accomplishments that addresses your expected performance relating to 
your performance objectives and incorporates your performance elements. 

Accomplishments related to your performance objectives comprise 60% of your eventual annual performance 
rating. The other 40% of your rating comes from your six performance elements. A self-report should address 
how you incorporated each of the performance elements throughout the performance period. 

Performance elements pertain to your entire job, not just the specific performance objectives. Very often you 
will incorporate your performance element accomplishments directly into the performance objective 
accomplishments. For the purpose of this activity, they are listed separately. 

Some organizations have the flexibility to write their performance elements within the performance objectives 
input instead of writing them separately. Check with your component-specific guidance to ensure you are 
writing them correctly. 
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Coach Script: 

The key to effectively addressing how you applied performance elements to your performance objectives is to 
consider each performance element individually. Think of ways that you used each to increase the 
effectiveness of your overall performance. 

As an example, let’s consider communication. You’ll want to use the performance standards for communication 
that apply to your work category and level as a guide. 
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Generate My Performance Objectives and Self-Report of Accomplishments 

To generate the document containing your performance objectives, Self-Report of Accomplishments, and other 
information: 

• Select Generate Document. 
• Select Copy to Clipboard in the new document window if you want to save the contents to a file and 

work with it later. 
OR 
Select Print if you want a printed copy. 

If you select Copy to Clipboard, follow these steps to save the file: 

• Open a new Microsoft Word document by launching Word and choosing File>New... 
• Select Edit>Paste. 
• Select File>Save. 

If pasting text from the saved document into a web-based application, check the pasted text for special 
characters that may not have pasted correctly. 

 

 
Select Generate Document to create the performance objectives information file. 
 
Narrator Script: 

You are now ready to create a separate document with your performance objectives, Self-Report of 
Accomplishments, and any other information you have entered. Follow the directions on the screen to either 
save it to a file or to print it. 

NOTE: When pasting text from a Word document into fields in external systems, certain characters may not 
display properly. They usually appear as an empty box. To address this problem, check the text in the field 
after you have pasted it and retype any characters that do not display properly. 

After you have created your document, please take a moment to complete the evaluation and print your 
certificate on the next screen. Follow these steps only after you have generated the file and have either printed 
or copied and pasted the information from it. Remember, this information will be lost unless you follow these 
steps. 
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Course Certificate 

You have finished iSuccess.  

For more information on any of the topics discussed, 
see the DCIPS training website at 
http://dcips.dtic.mil/training.html or contact your 
organization’s HR training POC. 

Use the button below to complete and print your 
certificate. Contact your HR organization for 
instructions regarding where to send your certificate.  

Select Exit (“x” at the top right corner of your screen) 
after you have printed your certificate.  

 

 
 
Select Open Course Certificate to complete the certificate. 
 

http://dcips.dtic.mil/training.html
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